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Who’s In The Barn?

“Who’s in the Barn?” is a set of instructions, 
materials, and finished examples for a workshop on 
authoring custom activities in IntelliPics Studio 3®, 
the multimedia part of IntelliTools Classroom 
Suite®.

In this workshop, you will toggle between Design and Paint modes to 
prepare the page background for animation.  You will set up a Page 
Button to control the action, so that a child using the activity decides 
when things happen. You will learn how to have more than one sound 
play on a single page. You will find out how to use an advanced 
IntelliMation option: playing part (a range) of the IntelliMation, in 
effect having multiple animations on a single page. You will also find out 
how to put a random factor into an activity, by drawing items from a 
hidden toolbar.  Best of all, you will end up with three finished 
activities, ready to use!

As you work through the instructions, be sure to pause and think about 
the tips you see in the blue boxes.  These not only apply to this 
workshop, but are general rules or insights that will make you a better 
author in Classroom Suite, whatever project you take on. 

Organization
The workshop instructions are organized so that you can print out each 
of the three parts as a separate handout. Parts 1 and 2 could be used 
with beginning and intermediate authors in Classroom Suite. Part 3 is 
more advanced, but builds on the first two parts and should be within 
the ability of someone who has completed the first two sections.  

A summary of skills and tips covered is provided at the end of each 
section, and a full list of general tips follows the three parts as a 
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separate handout.  This tips list would be a nice extra for any 
authoring workshop, as it is not limited to this particular project. 

Depending on the skill level of the participants and how much time you 
allot for experimentation, allow three hours minimum for a very 
advanced group, perhaps all day for typical Classroom Suite users, and 
expect to extend into a second half day for fairly novice authors.  Be 
sure all participants take the examples with them for reference, as 
well as the instructions and tips.

A Word About Standard Toolbars
There are many choices for basic toolbars under the View menu, 
including the Authoring Toolbar. The workshop instructions refer to 
menu choices, but you can also find most of these options on the 
Authoring Toolbar, and may prefer having it in view and using it for 
this workshop.  Students do not use any standard toolbars to run these 
activities, so standard toolbars should be hidden.

The particular Standard Toolbar displayed in an activity depends on 
which has been chosen on that computer, and this setting is not saved 
with the activity, unless you choose and save the activity with an option 
to hide standard toolbars.  In ClassRoom Suite v.3.00 or later, you can 
set this as your first step. Under Options-->Document Settings, click 
the Toolbars tab, and pick the second choice, that hides standard 
toolbars from students. Although you have access to and can see the 
Authoring Toolbar, students will not see any of the basic toolbars 
when they open the activities.  For earlier versions of Classroom Suite, 
you must wait until your final save to make this setting, because in 
those earlier versions standard toolbars were then hidden from all 
users, including teachers and administrators.

A Sneak Peek at “Who’s in the Barn?”: Barn Examples
To get an idea of what you will be making today, import the three 
example versions of “Who’s in the Barn?” and take a look at them.  To 
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do this, run Classroom Suite, click the Activities button, and then click 
the Import button. Navigate to the zip file of Barn Activities, and 
choose it.  The zip file will be decompressed as the activities are 
imported, and you will find them in a new folder called Barn Examples. 

Open the Barn Examples folder, and run “Who’s in the Barn sounds”.  
Try it out. This is the activity we will create in Part 1.  Clicking the red 
“Who’s in the Barn?” title will cause one of three animal sounds to play, 
in random order. Only this title text will be part of a scan. This is a 
finished activity, but we can add more!

Open “Who’s in the Barn sounds-door”.  Now there is a green Open the 
Door button. It runs a short animation, then plays one of the animal 
sounds. This is an extension of the first activity, and we will add the 
elements to create it in Part 2.

The third activity, “Who’s in the Barn”, is the final version.  In it the 
Open the Door button causes the door animation to run, then a sound 
plays, and an animation of the appropriate animal plays. The green 
button changes to a red Close the Door button. When a student clicks 
it, an animation of the door closing plays, and the activity resets, so 
that the green button shows and the door is closed.  We will add these 
animations in Part 3.

Tip 1:  Always import and export from Classroom Suite.  When you export 
one or more linked activities, they and all attached files (overlays, large 
sound files, movies, and/or PDFs) will be exported together and can be put 
into a zip file in that same operation.  When you import one of these 
exported files, all included files will be placed in the proper location, and all 
links will be retained.

Tip 2:  Build new activities by adding on to or changing activities, including 
the ones that ship with Classroom Suite. But be sure you work with an 
activity enough to understand the machinery behind it. Check for hidden 
toolbars, and items that appear or disappear as a result of animation.  
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Part 1: Cause and Effect Activity With Random Sounds
In this first section, we will set up the basic “Who’s in the Barn” 
activity, and use a hidden toolbar to store three animal sounds.  An 
invisible button will draw randomly from this toolbar when a student 
clicks it.  Example: Who’s in the Barn? sounds activity.

Adding Background and Checking Page Actions
1. Get Classroom Suite running, click New, and open a new, blank 
IntelliPics Studio 3® document.

2. Control-click on the blank page to open Page Properties.  Click the 
Background tab. Click the small folder icon to load a picture from a 

file. Navigate to the BarnBackground.jpg that came with 
the Barn Activities. Choose this, but don’t close Page 

Properties yet.

3. Click the Actions tab.  Notice the default page action, Play 
IntelliMation and Page Sound. If we added an animation and/or sound 
to the page, this action would automatically run it when the page opens.  
But we do not want anything to happen automatically. Instead, we want 
things to happen when the student clicks a button. So for this activity, 
we want to remove that default action. Remove it now, and then close 
Page Properties.

Creating a Custom Toolbar with a Sound Button
1. From the Edit menu, choose Custom Toolbars and Buttons….  Click 
the Create Toolbar button, up on the green top bar. A dialog will open. 

Tip 3:  A new, blank IPS3 document has a default action in the page, Play 
IntelliMation and Page Sound. Decide if you want either or both of these 
things to happen when the page opens. If not, remove this action, and use 
page buttons or toolbar buttons to give control to the student. If you want 
an automatic page sound, remember that you also have to import or record a 
sound and mark it for the page.  
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Name the new toolbar Animals.  By default, clicking OK at this point 
will create the first new button for the Animals toolbar.  Do that now.

2. Once you click OK, the Create Toolbar dialog closes, and you will see 
two floating windows. The yellow one relates to the entire toolbar, and 
lets you make new buttons and set the toolbar properties.  The blue 
one relates to whichever button is currently selected, in this case the 
new untitled button you just made. 

3. Click to open Button Properties. Name the new button Cow. Click the 
Actions tab. Notice that the default action is Insert Picture or Name.  
Since we do not want this button to do that, Remove the default 
action.  

4. Above the Button Actions window are the two windows of the 
Actions library. On the left are categories of actions, including one at 
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the top to list All available actions. When you choose a category, the 
actions included in that category will display in the right-hand window.  
Choose the Play category, look to the right, and choose Play Sound. 
Then click the Add: button to put the Play Sound action into the 
bottom window.

5. We added a command to play a sound, but there is no sound to play. 
Click the Sound tab. Here we can use synthetic speech, record a sound, 
or import a sound file. Click the Import... button, and navigate to the 
Classroom Suite Media folder, into the Sounds folder and into the 
Animals folder.  Choose the cow sound. Make sure the radio button 
beside the words Recorded Sound is active, and  that the cow sound is 
highlighted. Click OK.

6.  Click Done up in the green bar to exit the toolbar editing mode.  
Don’t worry about the appearance of the button, because in the final 
step we will hide it. Go ahead and click the button. Did you hear a moo? 
Great! You have everything set correctly.

TIME TO SAVE!  Be sure to choose Save as Activity. Call this 
activity something like “My Barn Sounds”, to distinguish it from 
the similar example activity.

Adding More Buttons and Hiding the Toolbar
1. We want to have two other sounds for this activity. We need two 
more buttons. Again go to Edit menu, choose Custom Toolbars and 

Tip 4: Notice that choosing an action from the list of available actions  
puts the chosen action into the “Add” box below the two windows, and 
above the Button Actions list.  It still is not in place as an action for the 
button. You must click the Add: button to actually place the action into the 
list to use it for this button. Alternately, you can double-click an action in 
the upper window to directly add it to the list of button actions, bypassing 
the Add box. 
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Buttons…. Once edit mode opens, choose your Animals toolbar, which 
for now has only one button. Notice that the yellow Selected Toolbar 
window is open for the Animals toolbar, and also the blue Selected 
Button window is open for the cow button, since you chose it. We could 
use the New Button choice on the yellow window, but then we would 
have to remove that default action and add the Play Sound action. 
There is an easier way.

2. In the blue Selected Button window look for a copy option at the 
top. It looks like two sheets of paper.  Click Copy once, and then click 
Paste twice. The paste icon looks like a clipboard. Now look at your 
Animals toolbar. You should see three Cow buttons. We will edit the 
two extras, changing the name and loading in different sounds. We 
know the actions are already set properly, so we do not have to change 
the actions.

3. Choose the second Cow button, and control-click to open its 
properties. Change the name to Pig. Click the Sound tab. Click 
Import.... and again navigate through Classroom Suite to Media to 
Sounds to the Animals folder. Scroll down and choose the pig sound. Be 
sure the radio button beside Recorded Sound is still active and the pig 
sound is highlighted. You will also see the cow sound listed, since it now 
is part of the activity file. But this button will play the one sound 
highlighted for it. Click OK to close the button properties. Now the 
second button name should be Pig.

4. Control-click the third button in the Animals toolbar. Open the 
Button Properties and change the name to Rooster. Click the Sound 

Tip 5: If you are creating a toolbar with many buttons that are similar in 
function, it may be fastest to finish and test the first button, make copies 
of it, and then make changes in the copies. Things you would usually change 
would be the name, the picture, and perhaps the assigned sound.  This is a 
real time saver when your buttons have multiple actions, and all  or most of 
the actions are the same for each button.
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tab, click Import..., navigate to the rooster crowing sound, and choose 
it. Be sure the rooster sound is highlighted before you close the Button 
Properties.  You should see the cow and the pig sounds listed, too.

5. Click Done again to exit toolbar editing. Try all three buttons. If you 

hear the expected animal sound for each, the Animals toolbar is ready 
to use. But students using this activity will not click actually these 
buttons, so we will hide this toolbar. We can choose these buttons 
while the toolbar is hidden.

 TIME TO SAVE!  Be sure to choose Save as Activity
 

6. Go to EditCustom Toolbars and Buttons again. On the yellow 
Selected Toolbar window, put a check in the Hide toolbar box down in 
the lower left corner. The Animals toolbar turns into a small rectangle 
to show that it is hidden. Click Done once more to exit editing again.  
We are ready to set up the machinery to use the sounds we just made.

Tip 6: If you use the default choice to play a page sound, you can only have 
one sound per page. But both toolbar and page buttons can control sounds 
with a Play Sound action and a highlighted sound in the sounds list. This 
gives you the power to have multiple sounds play on a page.  You could have 
several buttons with sounds for students to click. 

You also could hide a toolbar full of sound buttons, and have a visible button 
choose one of the hidden buttons to play sounds. A third choice is to hide 
the sound buttons toolbar, and then have a series of page actions that would 
choose each of the sound buttons in the order you desire when the page 
opens. 
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Adding Title Text Box
1. Set the attributes for our title 
under the Text menu. I used a red 
color to match the barn, Comic Sans 
Bold, and size 48. You may prefer some 
other color or font, but do use at least 
48 for the size. 

2. Get the text tool and click and drag 
to make a text box. Type in the title Who’s in the Barn?. Move the 
text box until it is where you want it to stay.  I centered mine over the 
barn. You may want to move it to the left, but be sure it is up in the 
sky area.  Save the area at the bottom of the page for animation.

3.  When you have the text box 
positioned, control-click on it to open 
Properties and make more settings. Take 
the checkmark off Show Background, so 
that the sky will show through. Leave 
Show Frame on, to give a visual clue to the 
edges of the title rectangle.  Make sure 
the text is marked Read Only. Also note 
the default name, Text Box. You will need 
to remember the exact name, since we use 
that in the master button. The action 
where will we use this is case sensitive. Leave Button Properties open 
for now.

4. In most activities, you would leave a text box set just this way. It 
would be part of a scan, and when a student chose it or clicked 
directly, the title would read out. 
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However, in this case we want to have two things happen, one after the 
other, with one click. We want the text to read out, and then we want 
one of the animal sounds to play. To do that, we need to control the 
action from a master button.  If we leave the text box clickable, that 
will confuse things.  So this time we want to make some special settings 
to avoid that confusion.

5. Click on the Scanning tab, and take the checkmarks off Automatic 
Scan and Step Scan. Also remove the checkmark from Respond to 
Mouse Clicks. The only way to make this text read out now will be the 
master button. Finally, be sure to Lock Position before closing 
Properties.

 TIME TO SAVE!  Be sure to choose Save as Activity.

Setting Up the Master Button
1. All the hidden machinery is in place, and it only remains to create a 
switch so that a student can run this activity. For that we will make a 
page button, which will control all the action.  Get the Page Button tool 
now, and click and drag to make a button. The Page Button Properties 
window will open.

©2008 ann brundige studio  www.annbrundigestudio.com
An IntelliTools Classroom Suite® lesson from Annie’s Resource Attic

2/29/08  11

http://www.annbrundigestudio.com
http://www.annbrundigestudio.com


2. Give the button a name that will be a good cue for the user. I used 
“Ready”, maybe you would prefer “Start” or some other name. This is 
what the student will hear if you have the activity set to speak when 
scanning. If you do not need to use this setting, the name can be 
anything. Leave Page Button Properties open.

3. Click the Actions tab.  Notice that the default action for a Page 
Button is Play Sound....  Once again, we are doing something unusual 
and do not need that action. Remove it now. 

4. From the actions categories list in the upper left window, scroll all 
the way to the top and choose All as the category.  Then scroll down 
through the long list of available actions in the right window. Find the 
action  Select Object... and double-click to send it into the Page 
Button Actions window below. A little dialog box will open. Any action 
with the ellipsis (...) after it needs some parameter information, and 
will open a window for you to enter it.  Here we want to tell the action 
which object to select. Type Text Box, being careful to capitalize the 
words and put only one space between them.  Click OK.

Next, choose the Read category from 
the left window. From available actions on 
the right, double-click Read All (or click 
the Add box) to send this action into the 
list of Page Button Actions. Be sure the 
Read All action comes after the Select 

Object... action. If it is out of order, move it using the Move Up or 
Move Down options.  

5. If we clicked the button at this point, the title text would read out. 
We also need to add something to play the animal sound button. 
Because we want a different animal sound button chosen each time, we 
need to add an action that will choose randomly from our hidden 
toolbar.  Luckily, there is one!
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6. To add it, again choose the All category from the left window.  
Scroll down through the list on the right and choose Draw Randomly 
From...  When you double-click to add it, a dialog will open, asking you 
to enter the name of the toolbar to choose from. Type Animals, if this 
is what you named that hidden toolbar. Again, you must be careful to 
type the exact name. This action will remotely click one of the three 
hidden buttons.  Lock the position of the Start button, and then click 
OK to close the Page Button Properties.

7. Test the Start button.  Each time you click, you should hear and see 
“Who’s in the Barn?” read out, and then in a moment you should hear 
the sound from one of your three animal buttons. Keep clicking until 
you have heard all three sounds play.

Congratulations! You have made a simple activity with several 
sophisticated tricks behind it. 

TIME TO SAVE!  Be sure to choose Save as Activity. 

8.  You could leave the activity just as it is, and a student could use it. 
But I thought it would be fun to have the student click right on the 
title to make things happen. We can do that by moving the button on 
top of the title, and changing its appearance.  

Tip 7: The Select Object... action is very powerful, and yet it is often 
overlooked. You can type in the name of text boxes, page buttons, and 
graphics that are on the current page.  You can even use it for a hidden 
page button. Selecting a page button is just like clicking it. For text 
boxes and graphics, you would use Select Object “Name” followed by an 
action that affects that object. Here we select a text box and read it 
out. If there were three text boxes, each with a different name, you 
would use three Select Object actions, each followed by Read All.  You 
could also do other things, like select a graphic and move it to a region.
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Drag a capture rectangle around the Start button to select it, and type 
control-L. That’s a shortcut to unlock the position.  Move the button 
over the title text, and adjust the size so it matches the  text box 
frame. Then control-click on the Start button to open its Properties 
again.  Click on the Appearance tab.

Under Appearance, scroll down through the list of Button Styles and 
choose Transparent. Lock the position again, and click OK.  Now when 
you click on the title, you really are clicking the start button.  The 
activity will work just as before.

TIME TO SAVE!  Be sure to choose Save as Activity.

Your first activity is all finished, ready to assign to a student.

Extra Credit:
Add more animal sounds.  All you need to do is add more animal sound 
buttons! Edit the Animals toolbar. Copy and paste any of the buttons, 
and change the name and the sound. Load a new imported sound from a 
file, or record the sound. Be sure the new sound name is highlighted 
before you close the new button properties. Save as Activity again.

*Take A Break!  You’ve earned it! 
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Outcome from Part 1 

You have created a finished cause and effect activity, My Barn  
Sounds, which can be assigned from inside Classroom Suite.

You have added a background picture.
You have created a new custom toolbar with three buttons.
You have set up toolbar buttons to each play a different sound.
You have copied and pasted toolbar buttons to add to the toolbar.
You have learned how to hide a toolbar.
You have created a page button to control a list of actions, including 

selecting and reading text and drawing randomly from and 
activating buttons in a hidden toolbar.

You have learned the following tips:
Tip 1:  Always import and export from Classroom Suite.
Tip 2:  Build new activities by adding on to or changing activities, including 

the ones that ship with Classroom Suite.
Tip 3:  Decide if you want the automatic effect of Play IntelliMation and 

Page Sound, the default page action in a new IPS document. If not, 
remove this action.

Tip 4: Choosing an action from the list of available actions  puts the chosen 
action into the “Add” box below the two windows.  You then must click 
the Add box to actually put the action into the list for the current 
button.

Tip 5: If you are creating a toolbar with many buttons that are similar in 
function, it may be fastest to finish and test the first button, make 
copies of it, and then make changes in the copies.

Tip 6: You can have only one page sound. Use toolbar and/or page buttons 
with a Play Sound action and you can have multiple sounds play on a 
page.

Tip 7: The Select Object... action can select text boxes, page buttons, and 
graphics that are on the current page.
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Part 2: Activity With IntelliMation and Random Sounds
In the next part of the workshop, we will add some animation to the 
random sounds activity you created in Part 1.  Having the master 
button, hidden toolbar, and individual sounds buttons already made will 
save us lots of time in creating an activity like Who’s in the Barn? 
sounds-door, the second example activity.

Our goal is to create a door graphic to use with the barn background 
picture, and to make a short animation of the door opening that will 
play when the title is clicked and before the animal sound. This 
animation will make the activity more interesting for the student, and 
add the element of a visual cue that helps the student to anticipate a 
sound.

Preparing a Floating Graphic From a Background
1. Run Classroom Suite and open your My Barn Sounds activity, if you 
have not already done so. We are in Design mode by default, but we 
want to work with the background photo and need to be in Paint mode 
to do that.  Go up to the IntelliPics Studio menu and choose Paint 
mode. 

Tip 8: Use finished activities, both ones you have made and others, as 
templates.  Customizing or adding onto an activity saves you time. You 
may need several versions of an activity to use with different students. 
It also is a good way to stretch your authoring skills without biting off 
too much at once.  If you use another author’s activity, spend enough 
time looking behind the scenes to be sure you understand how it works.  
Then make whatever changes will fine-tune it for your students’ needs. 
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2. Get the marquee tool and select a rectangle around the area to the 
right of the barn door opening. Just select enough 
background to make a door to cover the opening. 
Copy the selection. You can type control-c or you 
can select Copy from the edit menu. Do NOT move 
the selection. Deselect once you have copied the 
rectangle onto the clipboard BUT do not paste yet. 

3. Go up to the IntelliPics Studio menu again and 
choose Design. Now we are back in the default 
mode, and a pasted graphic will float instead of 
sinking into the background. Paste, and you should 
see your rectangular door graphic floating above 
the background.  Move the door graphic to exactly 
cover the black door opening. 

4. Control-click on the small door graphic to open its Properties. Check 
the Properties window, and make sure it says 
Properties of Picture at the top. If it says Page 
Properties, then you clicked in the background 
accidentally. Name the graphic Barn Door.

5. This door will not be a part of a scan, so click 
the Scanning tab and remove the checkmarks for 

Automatic and Step scans.  Click OK to close Properties. You now have 
a floating graphic that matches the photo to use for our animation.

Tip 9: Use Paint mode to create a floating graphic you can animate from 
a background photo.  The procedure is to go into Paint mode, select and 
copy the rectangular area you need, go immediately back to Design mode, 
and paste. The result is a floating graphic that you can animate. If you 
need to trim the rectangle to the edge of a shape, go to a new blank page 
while in Paint mode, paste the rectangle, and erase around it. Then select 
and copy again, go to Design mode, and paste. 
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Changing the Master Button To Run IntelliMation
We need to add an action to our master button to run the animation. At 
the same time, let’s change its appearance.

1. Currently, the master button is transparent and is on top of the title 
text. Control-clicking to open Properties may select the text box by 
mistake.  Instead, go to the Edit menu and choose Select Object. In 
the pull-down menu beside it, choose Start, if this is the name of your 
master button. Then, also from the Edit menu, choose Properties..., to 
open the Properties window for the selected object, in this case Page 
Button Properties.

2. For this version of Who’s in the Barn?,  we want to give the student 
control of when to open the door, rather than just doing cause and 

effect. For that, the button should be visible 
and its label should relate to the door 
animation.  

Change the name of the button to Open The 
Door. Then unlock the button by removing the 
checkmark beside Lock Position. Click on the 
Appearance tab in Page Button Properties.  
Choose to show the Button Name only, and 
make the text Comic Sans 24 Bold. Under 

Button Styles, choose Green.  Click OK to close Page Button 
Properties. 
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3. Move the button, which now is green, off of the title text and down 
to the left of the barn. Resize it so it is about as large as will fit there. 
Type Control-L to lock the button’s position. 

4. Control-click the green button to open its Properties again, and this 
time click the Actions tab.  In the list of categories, choose 
IntelliMation and in the set of actions on the right, double-click Play 
IntelliMation and Page Sound, to add this action directly to the list of 
actions for this button.  

5. Check the list of button actions in the bottom window. It is 
important that they be in the 
correct order. First should be the 
Select Object “Text Box” and the 
Read All actions, to read out the 
title. Next should be the Play 
IntelliMation and Page Sound 
action, to run an animation of the 

door opening.  Right now, this won’t do anything, because we have not 
yet created the IntelliMation. The last action in the list, Draw 
Randomly From Animals, is what actually activates sounds, by remotely 
clicking a button in the Animals toolbar.  If your Button Actions list 
looks correct, click OK to close the Page Button Properties.

 TIME TO SAVE!    Be sure to Save as Activity, and choose 
a new name.  Call this one My Barn Sounds-Door.

Tip 10: When objects are stacked on top of one another, you can still 
easily select one for editing by choosing Select Object from the Edit 
menu, and picking the object from the list of object names in the flip out 
menu beside it. Next choose Properties... from the Edit menu to open 
the Properties window for the selected object.
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Using the Floating Graphic in IntelliMation
1. From the IntelliPics Studio menu, choose Create IntelliMation. This 
will open the timeline. Think of it as a time machine, on which you can 
click to jump ahead or back and see the position and other 
characteristics of everything on the page at various times.  By 
contrast, when you actually run the animation, you see a continuous 
stream of images as the time segment passes.  For now, click on the 0 
seconds timepoint.   Make sure the barn door graphic is in position over 
the door opening.

2. Think about how long you would expect the animation actions to take. 
If we allow 2 seconds for the door to open, it should be about right: 

not so fast a student would miss the motion but fast enough not to 
bore the student. So click the 2 second timepoint and then move the 
door graphic to the left, placing it beyond the black door opening.

In this type of animation, the path and speed along which you drag are 
not recorded. The timeline makes a snapshot of the final location of 
the graphic at each timepoint. So relax and take your time, putting the 
barn door graphic exactly where you want it to be at the end of the 
animation.

3. Before closing the timeline, make final settings on the graphic. While 
you are still at 2 seconds, control-click on the graphic 
to open Properties again, and remove the checkmark 
on Respond to Mouse Clicks. Lock Position, and click 
OK. 

Then click the 0 seconds timepoint. You should now 
see the door over the opening, since we have moved 
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back in time to a point before you opened the door. Control-click the 
door graphic to open its Properties again. Notice that the checkmark 
for Respond to Mouse Clicks is still set, here at 0 seconds, and the 
Lock Position box is blank. You must again remove the checkmark on 
Respond to Mouse Clicks,  Lock the position, and click OK to close 
Page Button Properties. 

4. Try out the animation by clicking the black triangle at the end of the 
timeline. Be sure you click the 0 seconds point before closing the 
timeline, so that you leave Create IntelliMation at the starting point. 
Toggle the timeline closed by choosing Create IntelliMation again up in 
the IntelliPics Studio menu.

 TIME TO SAVE!    Be sure to Save as Activity.  

Adding A Reset Action To The Animals Toolbar
We have one more change to make. If the green button is clicked now, 
the title text will read out, the animation will make the door open, and 
then one of the animal sound buttons will play. But there is nothing to 
reset the activity, so that the door is closed again.  We know that the 
door would be closed if we are at the 0 second timepoint on the 

Tip 11: If a graphic will not be clicked by a student, remove it from scans 
by opening Properties and taking off the checkmarks under the Scanning 
tab. Also remove the checkmark from Respond to Mouse Clicks, to 
prevent a reaction from direct selection. If a student can interact with a 
graphic, there should be some effect or reward; otherwise, set it so it 
seems to be part of the background.

Tip 12: The timeline really does act like a time machine. If you forgot and 
made a change at, say, 2 sec, then it would not be there at time 0.  
Things added at 0 remain for future points unless you delete them at a 
later timepoint. In fact, like in the real world, things added at any 
timepoint will remain at a later new timepoint, but will not appear at 
earlier timepoints.
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IntelliMation timeline. We need a way to move to 0 seconds after the 
animal sound is played.  Since it could be a sound from any of the three 
hidden buttons, we must make the same change to all three buttons.  

1. Go to the Edit menu and choose Custom Toolbars and Buttons.  On 
the yellow Selected Toolbar window, remove the checkmark from Hide 
Toolbar. You will then see the three animal buttons. 

2. Select the first button, Cow, and open its Properties from the blue 
Selected Button window. Click the Actions tab.  In the list of action 
categories, choose IntelliMation and in the set of actions on the right, 
double-click Set IntelliMation Time...  A dialog box will open. Choose 0 
seconds, and click OK. Make sure the action, Set IntelliMation Time 
to 0, is in the Button Actions list in the lower window, and that it is 
after the Play Sound action.

3. Notice that the Play Sound action has the default setting, (Do Not 
Wait).  If we leave the action set this way, the sound will begin but the 
next action, which makes the door appear to close, will happen before 
the sound is finished.  It would look more natural if the door closed 
after the sound had finished.  We need an action to make sure the 
sound is finished before going to the Set IntelliMation Time 0 action 
begins. 

Tip 13: You can use the Set IntelliMation Time... action as a reset.  If 
you play an animation, it does not automatically jump back to 0 seconds 
after it plays. A button with Play IntelliMation and Page Sound will 
indeed cause it to go to the 0 point and play to the end. But having it 
jump back when the button is clicked sometimes looks silly. If so, add 
Set IntellMation Time to 0 after Play IntelliMation and Page Sound.
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Click the Edit button just to the right of Play Sound.  A dialog will 
open. Put a checkmark in the box so that the next action is delayed 
until the sound is finished.  Click OK. Notice that the action now says 
Play Sound (Wait). Click OK again to close the Button Properties for 
the Cow button.

4. Follow steps 2 and 3 for the other two buttons, Pig and Rooster.  
Once all three buttons have the reset action (setting time to 0) and 
Play Sound (Wait), put a checkmark in the Hide Toolbar box on the 
yellow dialog. Then click the Done button, to exit toolbar editing.

 TIME TO SAVE!    Be sure to Save as Activity.  

Try out your extended activity. When you click the green button, first 
the title text should read out, then the door should open smoothly, an 
animal sound should play, and the door should pop closed as the activity 
resets. Click until you have heard all three sounds.  You’re done!

Tip 14: Activating the (Wait) option for Play Sound makes certain that 
the sound will play completely before going on to the next action.  This 
may be exactly what you need to have a voice-over complete itself.  It 
can also make sure a sound finishes before going to the next page. If a 
sound is being cut off by the next action, turn on (Wait)!
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Congratulations! You added an animation to your activity.  In this 
extended activity, the student decides when to open a door, and can 
anticipate hearing a sound. This is good practice use for animation. It is 
not decorative or distracting, but instead adds to the student’s 
experience of making things happen.  

Extra Credit
You can add more animal sound buttons to this activity, but be sure 
you set the timeline to 0 seconds before adding the buttons.  Copy 
and paste any of the buttons in the Animals toolbar as a template, 
change the button name in the copy, and load a new sound file. If you 
copy one of the buttons for a template, you can be sure the actions are 
already set to Play Sound (Wait) and Set IntelliMation Time 0.

*Take A Break!  You’ve earned it! *
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Outcome from Part 2

You have added features to a finished activity to create a new one, My 
Barn sounds-door .

You have used Paint and Design modes to create a floating graphic that 
matches a photo background. 

You have changed a page button’s appearance and location to make it 
appropriate for this new activity.

You have added a short animation to make the activity more realistic, 
to give the student a better reward for action, and to create 
anticipation for the animal sounds. 

You have used an advanced IntelliMation option, Set IntelliMation 
Time 0, to create a reset for the activity. 

You have added the reset to the buttons in a hidden toolbar and also 
used a Play Sound option, (Wait) to make sure the action sequence 
is correctly timed.

You have learned the following general tips:
Tip 8:  Add on to your activities to save time in building new ones. 
Tip 9:  Use Paint mode to create a floating graphic you can animate from a 
background photo..
Tip 10:  When objects are stacked on top of one another, you can still easily 

select one for editing by choosing Select Object and then Properties... 
from the Edit menu .

Tip 11: If a student can interact with a graphic, there should be some effect 
or reward; otherwise, set it so it seems to be part of the background. 

Tip 12: The timeline really does act like a time machine. Things added at any 
timepoint remain at a later new timepoint, but will not appear at earlier 
timepoints.

Tip 13: You can use the Set IntelliMation Time... action as a reset 
Tip 14: Activating the (Wait) option for Play Sound makes certain that the 

sound will play completely before going on to the next action.

©2008 ann brundige studio  www.annbrundigestudio.com
An IntelliTools Classroom Suite® lesson from Annie’s Resource Attic

2/29/08  25

http://www.annbrundigestudio.com
http://www.annbrundigestudio.com


Part 3: Add Multiple IntelliMation Segments
Our activity with the barn door opening and a randomly selected animal 
sound is already interesting for a student, but would be even better if 
the animals really ran out when the door opened.  We can set that up 
using IntelliMation, but we will be getting into advanced options.   
Follow the instructions carefully, to produce an activity like the third 
example, Who’s in the Barn.

Our goal is to add an animation to each of the hidden animal sound 
buttons.  Since we can only have one IntelliMation on a page, the only 
way to do this is to combine all these animation sequences into one big 
animation, but have each button only play the part of the IntelliMation.  
We can then use an advanced IntelliMation option, Play Range, to 
direct each button to play its section.  So our strategy will be to 
construct the IntelliMation using the timeline, art from the Picture 
Library, and the Transformation Tools, and then to edit the three 
buttons of the Animals toolbar so that each button plays its specific 
part of the IntelliMation.

Creating the Cow IntelliMation
1. Open the activity from Part 2, My Barn sounds-door, and save a 
copy under a new name, such as Who’s in the Barn 2. (The next steps 
are involved, and we do not want to accidentally save over our Part 2 
activity or the example activity).

 TIME TO SAVE!    Be sure to Save as Activity. 

We will also need the Transform Tools, which can be accessed from 
the Authoring toolbar.  If it is not currently visible, choose the 
Authoring toolbar from the View menu. (If this choice is grayed out, 
check the document settings and temporarily remove the checkmark 
beside Hide Standard Toolbars.)
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2. Choose Create IntelliMation from the IntelliPics Studio menu, to 
open the timeline. Notice that the timeline is already green between 0 
and 2 seconds, where we made our opening door animation.   We will use 
later timepoints for our animal animations.

3. Click on the 3 seconds timepoint. Because we opened the door 
between 0 and 2 seconds, the barn door should still appear be open at 
this timepoint.  We are ready to add the first animal animation 
segment.

4. From the Edit menu, choose Insert Picture from Library. The 
Picture Library will open. Be sure the category in the upper left 
window is Animals or All. Type cow in the search area, and pick either 
the brown or black and white cow clip art. Click Insert to close the 
Picture Library.
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5. You should now have a floating cow graphic. Position it in the 
doorway.  The cow is too big, but 
we can easily adjust the size. On 
the Authoring toolbar, click the Transform and Arrange 
button. The Transform Tools will open. 
With the cow graphic selected, click Make 

Smaller until the cow looks small enough. Move it so it is 
entirely in the doorway.

6. Click the 5 seconds timepoint.  Move the cow forward in the picture. 
You can also move it off to the right a bit.  Notice the gray “rubber 
band” stretching back to the previous position. Click the Make Larger 
button several times until the cow graphic looks the right size to be in 
the foreground. 

If you try out the animation by clicking the black preview triangle at 
the end of the timeline, you will notice a long pause between the 2 and 
3 second points before the cow comes out. Don’t worry about that.  We 
will be jumping over that section by using Play Range, so we will let the 

Tip 15: You can use the Transform Tools within an IntelliMation to 
create the illusion of something moving closer or farther away.  Don’t try 
to change the size yourself at every half second.  Just set the size you 
want at the beginning, jump to the timepoint where you want to end up, 
and reset the size there. Classroom Suite will smoothly change the size 
in between. This tweening effect is built right in!
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door open and then jump directly from 2 seconds to to 3 seconds to 
see the cow emerge.

7. We will be doing a similar 2 second long animation segment for each 
of the other two animals.  These will naturally be located 
farther along the timeline. If we leave the cow in place, 

as it is at timepoint 3 seconds, then it will still be there at all later 
timepoints. To prevent that, click the 5.5 seconds timepoint. To see 
that part of the timeline, click the plus 5 seconds button.

Select and delete the cow graphic while at 5.5 seconds.

8. A student using this activity will not interact directly with the cow 
graphic. So go to timepoint 5, control-click the cow graphic to open 
Properties, and remove the checkmarks under the Scanning tab. Also 
remove Respond to Mouse Clicks, and then Lock Position for the cow 
and click OK.

Tip 16: You can create animations longer than 5 seconds by clicking the 
plus 5 seconds button.  The timeline is as long as you want it to be! You 
can move back to a previous 5 second section by clicking the minus 5 
seconds button.

Tip 17: In building a complex animation, plan ahead to delete items you no 
longer need, use the fewest possible points, and do segments in the order 
that will make best use of elements already in place. This will help you do 
the animation faster, and also make it easier to edit if necessary.  If you 
make a change in the middle of a bunch of timepoints, you must make 
that change in each later timepoint.
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9. Next, click the 3 seconds timepoint, and repeat the 
procedure in step 8 in order to take the graphic off 
scan, off respond to mouse, and lock it in place.  Our 
first animal animation sequence is done, but leave the 
timeline open.

Creating the Rooster Animation Segment

1. Click the 6 seconds timepoint. Since you deleted the cow graphic, 
the scene should look the same as at 3 seconds, with the barn door 
open and no animal in sight.

2. Open the Picture Library if it is not already 
open.  Locate and choose the rhode island red clip 
art. Click Insert, and you should have a floating 
rooster graphic.  Position it in the barn door, and 
use the Transform Tools to make it smaller. 

3. Click the 8 seconds timepoint. Move the rooster forward in the 
picture, and make it bigger. Then click the 8.5 seconds timepoint, and 
delete the rooster so it will not appear in later timepoints.

4. Go back to 8 seconds, control-click the rooster, 
and take it off scan and mouse response. Lock it. 
Then go to 6 seconds and again control-click the 
rooster, and take it off scan and mouse response. 
Lock it and click OK.  The second animal segment is 
finished. Leave the timeline open.
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Creating the Pig Animation Segment

1. This time click the 9 seconds timepoint.  You should see the scene 
with the door open, and no animals. Open the Picture Library if it is not 
already open.  Locate and choose the pig clip image. Click Insert, and 
you should have a floating pig graphic.  Position it in the barn door, and 
use the Transform Tools to make it smaller. 

2. Click the +5 button to view the next 5 seconds. Click the 11 seconds 
timepoint. Move the pig forward in the picture, and make 
it bigger. Then click the 11.5 seconds timepoint, and 

delete the pig so it will not appear in later timepoints. Later we will add 
a door closing segment, and we do not want to see the pig there.

3. Go back to 11 seconds, control-click the 
pig, and take it off scan and mouse 
response. Lock it. Then go back to 9 seconds by clicking 
the Previous 5 button. Again control-click the pig 
graphic, and take it off scan and mouse response. Lock 
it and click OK.  The third animal segment is finished. 

4. Click the 0 seconds timepoint to make sure we do our remaining 
editing while we are at the beginning of the IntelliMation.  Toggle the 
timeline closed by choosing Create IntelliMation again.

 TIME TO SAVE!    Be sure to Save as Activity. 

Animation Segments Reference
We will edit the three buttons in the Animals toolbar to play these 
animation segments. We will need to know the exact timepoints for 
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each animation, in order to enter the correct numbers for the Play 
Range action in each button.  So far, we have set up the following 
animation segments:

0 to 2  Opening the door
3 to 5  Cow animation
     5.5  Cow deleted here
6 to 8  Rooster animation
     8.5  Rooster deleted here
9 to 11 Pig animation
      11.5 Pig deleted here

Changing the Master (Open the Door) Button
1. Control-click the green Open the Door button to open Page Button 
Properties. Click on the Actions tab.

2. Highlight Play IntelliMation and Page Sound in the button actions 
list. Locate the Edit button to the right of the list of actions and click 
it. The action’s Options window will open.

3. Put a checkmark beside Play Range, and fill in the range numbers 0 
to 2 seconds. This is the section of the animation with the door 
opening. Click OK.
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4. Notice that the action now says Play IntelliMation and Page Sound, 
0 to 2.  It will look like exactly the same action as before, but now it 
will pause at 2 seconds in the IntelliMation, instead of playing all the 
way to the end, and will go to the next action. In the next action, one 
of the Animals buttons is chosen remotely, and we will specify which 
animation segment it plays in that button.

 TIME TO SAVE!    Be sure to Save as Activity. 

Using Play Range For Multiple Animations
1. We now must edit each of the Animals toolbar buttons, to add an 
action to Play IntelliMation over the range for that animal. First, 
choose Custom Toolbars and Buttons from the Edit menu, and then 
take off the checkmark for Hide Toolbar from the yellow Selected 
Toolbar window. The three Animals toolbar buttons will appear.

2. Select the cow button on the toolbar, and open its Properties by 
clicking the button on the blue Selected Button window. Click the 
Actions tab.

3. Choose Play from the categories in the upper left window.  Double-
click Play IntelliMation and Page Sound in the list of actions on the 
right, to send that action into the Button Actions list below. Use Move 
Up or Move Down to place this action after Play Sound (Wait) and 
before Set IntelliMation Time 0. 

Tip 18: Use Play Range, an advanced IntelliMation option, to play a part 
of an IntelliMation.  By specifying several different ranges in various 
buttons, you can in effect have more than one animation on a single page.
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Note: It may appear that we would hear two sounds when this button is 
chosen. But since we did not designate a page sound in the Page 
Properties, actually the only sound heard will be the animal sound for 
this button, which Play Sound (Wait) activates.

4. If we left the default setting for the Play IntelliMation and Page 
Sound action, the entire IntelliMation would play, and after the animal 
sound we would see the door open again, then see the cow, next the 
rooster, and then the pig. We only want to see the cow animation 
segment with this button.  So we will use this action’s special options to 
play a specified range of the IntelliMation.

Click the Edit button to the right 
of the Play IntelliMation and 
Page Sound action. The Options 
window for this action opens. 
Choose Play Range.  For this cow 
animation, enter 3 to 5 as the 

beginning and end timepoints.  Click OK to close Options.

5. Check that the action now says Play IntelliMation and Page Sound, 
3 to 5. Click OK to close the cow button’s Properties.

6. Next select the rooster button and open its Properties. Add the 
Play IntelliMation and Page Sound action, and move it if necessary to 
between Play Sound (Wait) and Set IntelliMation Time 0.  
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Highlight Play IntelliMation and Page Sound in the button actions list. 
Locate the Edit button to the 
right of the list of actions and 
click it. The action’s Options 
window will open. Choose Play 
Range, and enter 6 to 8 as the 
beginning and end timepoints. Click 

OK, check the actions list, and close the Properties window. 

7. Select the pig button, open its Properties, and add and position the 
Play Intel l iMation action. 
Highlight Play IntelliMation, click 
Edit, choose Play Range, and 
enter 9 to 11 seconds as the 
range. Close button Properties.

8. Put the checkmark back beside Hide toolbar, on the yellow Selected 
Toolbar window.   Click Done to exit toolbar editing.

 TIME TO SAVE!    Be sure to Save as Activity. 

Try out the activity.  You should see the door open, hear an animal 
sound, and see that animal run out each time you click the green 
button.  Then the door pops shut as the reset activates. Click until you 
hear and see all three animals. 

Adding the three animal animations lets the student associate the 
sound with the animal, and anticipate not only hearing the sound but 

Tip 19: Combining the Choose Random function with a toolbar of buttons 
that use Play Range lets you create cause and effect activities in which 
the animation doesn’t always come out the same.  
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seeing the animal as a result of choosing to open the door.  Again you 
have used animation in a way that adds to the educational value of this 
activity, as well as making it more interesting and fun.

The only flaw in our activity is that the animals disappear quickly, and 
the door pops shut faster than it opens.  We can take this activity 
another step beyond simple cause and effect by adding an animation 
segment in which the door closes smoothly, and setting up a second 
(Close the Door) button, so that the student decides when the door 
closes. This means the student can choose to look at the animal for a 
while before closing the door.  Let’s add that last bit of animation now.

Editing a Button Within an IntelliMation
1. Choose Create IntelliMation from the IntelliPics Studio menu,to 
open the timeline again. Let’s put our door closing sequence far along 
the timeline, to leave room in case you later want to add more animal 
animations. Click the Next 5 Sec button several times until you see 
the the part of the timeline from 25 seconds to 30 seconds.

2. Click the 25 seconds timepoint. If you remembered to delete the pig 
graphic after that section, you should see the door in the open position 

but no animal. Clicking the timepoint 
activates it so that the door closing 
action can begin here. Besides closing the 

door, we will also edit the green button while at this timepoint to make 
it a red button with actions to close the door.

3. Still at the 25 seconds timepoint, control-
click the green Open the Door button.  In 
the Page Button Properties window, change 
the name to Close the Door.

4. Click the Appearance tab, and change the 
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button style to red. You may also want to change the color of the 
button name text to white or yellow, for more contrast.

5. Click the Actions tab. Highlight and Remove the Select Object 
“Text Box” and Read All actions. Highlight and Remove the Draw 
Randomly from Animals action.  

6. Highlight Play IntelliMation, click the Edit button, and change the 
Range to 25  to 27 seconds. Click 
O K . A d d t h e a c t i o n , S e t 
IntelliMation Time, and enter 0 in 
its options dialog. Click OK again. 

7. Check that the position is still locked. Click OK to 
close the button Properties. You should now have a 
red Close the Door button at the 25 seconds 
timepoint. Now we need to actually add the animation 
segment from 25-27 seconds that this button will 
control. 
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8. Click the 27 seconds timepoint.  Select the Barn Door 
graphic, and move it to cover the door. (If the graphic is 
locked in place, control-click it to unlock it and 
temporarily set it to respond to mouse, then redo these 

settings once it is in position.) Toggle the timeline closed by choosing 
Create IntelliMation again from the IntelliPics Studio menu. 

 TIME TO SAVE!    Be sure to Save as Activity.

Editing the Animals Buttons to Jump To The New Red Button
We now have a door-closing animation section on the timeline, and a 
button that will play that section of the timeline and then jump back to 
0 seconds.  We still need to edit the three buttons on the Animals 
toolbar, so that they jump to the door closing section (the 25 seconds 
timepoint) when the animal animation for each button finishes, instead 
of resetting to timepoint 0.

1. First, choose Custom Toolbars and Buttons from the Edit menu, and 
then take off the checkmark for Hide Toolbar from the yellow 
Selected Toolbar window. The three Animals toolbar buttons will 
appear.

Tip 20: You can edit a button partway through an IntelliMation so that it 
looks different and has different actions. By having the action stop 
where the edited button resides in time, you can let students interact 
within an animation.
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2. Select the cow button on the toolbar, and open its Properties by 
clicking the button on the blue Selected Button window. Click the 

Actions tab. Highl ight Set 
IntelliMation Time, click the Edit 
button, and change the setting to 
25. Click OK. Click OK again to close 
the Properties of the cow button.

3. Select the rooster button on the toolbar, and open its Properties by 
clicking the button on the blue Selected Button window. Click the 
Actions tab. Highlight Set IntelliMation Time, click the Edit button, 
and change the setting to 25. Click OK. Click OK again to close the 
Properties of the rooster button.

4. Select the pig button on the toolbar, and open its Properties by 
clicking the button on the blue Selected Button window. Click the 
Actions tab. Highlight Set IntelliMation Time, click the Edit button, 
and change the setting to 25. Click OK. Click OK again to close the 
Properties of the pig button.

5. Put the checkmark back beside Hide toolbar, on the yellow Selected 
Toolbar window.   Click Done to exit toolbar editing.

 TIME TO SAVE!    Be sure to Save as Activity. 

To visualize this entire complex 
activity, refer to the flow 
chart. The two switches show 
the points where a student 
would control the action. 
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Try out your finished activity. When you click the green button, you 
should see the door open, hear and see an animal, and then you should 
see the green button change to red.  When you click the red button, 
you should see the door close, and then see the green button again. 
Click the green button until you have seen and heard all three animals.  

Congratulations! You added multiple animations to your activity, and 
even edited a button to control a different set of actions as part of 
the animation.  In this advanced activity, the student not only decides 
when to open the door, but can decide when to close the door, thus 
getting a chance to view the animal longer and think about what 
happened. 

Here animation is used as part of the navigation machinery, besides 
adding interest and content to the activity.  The cause and effect here 
is more like a real world experience, in that the student decides to 
open and close the door as a way of getting an anticipated result.  Does 
this suggest more ways to use IntelliMation?

Tip 21: You can take a screen shot of the thumbnails in Sort Pages... to 
make a flowchart of a multi-page activity. But for this activity, which all 
takes place on one page, I used pieces of clip art from the activity to 
show the flow of the actions.

*Wow! You’re becoming an 
expert author!  Give yourself 
a reward!  (donuts, maybe?:) 

©2008 ann brundige studio  www.annbrundigestudio.com
An IntelliTools Classroom Suite® lesson from Annie’s Resource Attic

2/29/08  40

http://www.annbrundigestudio.com
http://www.annbrundigestudio.com


Extra Credit
Add more animal buttons to the animals toolbar by copying and pasting 
any of the buttons, and changing the name and sound file.  Be sure you 
are at 0 seconds on the timeline when you edit the buttons.  Also make 
an animation segment for each new button, loading appropriate clip art 
and deleting clip art .5 seconds after the new section. These new 
animation sequences will fit after the pig animation (ends at 11.5) and 
before the 25 second point.  Note the timepoints for these new 
ranges, and enter them into the appropriate buttons on the Animals 
toolbar, in the Play IntelliMation action.

One problem:  Because you will be slipping these new sections into the 
middle of the IntelliMation, you will need to delete unwanted animal 
images from the door closing segment. Deleting these at both 25 and 
27 seconds should do the trick. Do NOT open every half second point, 
or editing will be much more involved.  As you can see, opening as few 
marker points as possible is a good strategy. 
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Outcome from Part 3 

You have edited an IntelliMation and added more animation.
You have used clip art from the Picture Library for the new sections.
you have used the Authoring Toolbar to access the Transform Tools.
You have used the Transform Tools to change the size of the 

animation art, to give the illusion of the animals moving closer.
You have used the Plus 5 and Minus 5 buttons to move beyond the 5 

second mark on the timeline and back again.
You have learned to use the Play Range option with the Play 

IntelliMation action to play parts of an IntelliMation.
You have edited the buttons on a hidden toolbar so that each plays a 

different range of IntelliMation, and then jumps to a closing 
sequence.

You have edited a button within an IntelliMation to change its 
appearance and actions.

You have learned the following general tips:
Tip 15: You can use the Transform Tools within an IntelliMation to create the 

illusion of something moving closer or farther away.
Tip 16: You can create animations longer than 5 seconds by clicking the plus 5 

seconds button.
Tip 17: In building a complex animation, plan ahead to delete items you no 

longer need, use the fewest possible points, and do segments in the order 
that will make best use of elements already in place.

Tip 18: Use Play Range, an advanced IntelliMation option, to play a part of an 
IntelliMation.

Tip 19: Combining the Choose Random function with a toolbar of buttons that 
use Play Range lets you create cause and effect activities in which the 
animation doesn’t always come out the same. 

Tip 20: You can edit a button partway through an IntelliMation so that it looks 
different and has different actions.

Tip 21: You can take a screen shot of the thumbnails in Sort Pages... to make 
a flowchart of a multi-page activity.
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Credits

The basic idea for Who’s in the Barn was a suggestion by Carol Smithers 
during an advanced workshop.

This tutorial is © 2008 by ann brundige studio.  You are welcome to use it for 
workshops, but please direct participants to Annie’s Resource Attic for 
more free materials.  You may also copy and distribute the 21 Tips 
section with this or any other workshop where it would be helpful.

The Who’s in the Barn activities in their finished form are ®2008 ann 
brundige studio. You may customize these as needed. If you distribute 
these activities, please direct people to the web site for Annie’s 
Resource Attic.

The barn background is adapted from a photo that ships with Classroom Suite.  
All other artwork consists of annotated screenshots from the activities 
as they appear in Classroom Suite.
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Twenty-One Classroom Suite Tips
from the Who’s in the Barn Workshop 

Tip 1:  Always import and export from Classroom Suite.  When you export one or 
more linked activities, they and all attached files (overlays, large sound files, 
movies, and/or PDFs) will be exported together and can be put into a zip file in 
that same operation.  When you import one of these exported files, all included 
files will be placed in the proper location, and all links will be retained.

Tip 2:  Build new activities by adding on to or changing activities, including the ones 
that ship with Classroom Suite. But be sure you work with an activity enough to 
understand the machinery behind it. Check for hidden toolbars, and items that 
appear or disappear as a result of animation.  

Tip 3:  A new, blank IPS3 document has a default action in the page, Play 
IntelliMation and Page Sound. Decide if you want either or both of these things 
to happen when the page opens. If not, remove this action, and use page buttons or 
toolbar buttons to give control to the student. If you want an automatic page 
sound, remember that you also have to import or record a sound and mark it for 
the page.  

Tip 4: Notice that choosing an action from the list of available actions  puts the 
chosen action into the “Add” box below the two windows, and above the Button 
Actions list.  It still  is not in place as an action for the button. You must click the 
Add: button to actually place the action into the list to use it for this button. 
Alternately, you can double-click an action in the upper window to directly add it to 
the list of button actions, bypassing the Add box. 

Tip 5: If you are creating a toolbar with many buttons that are similar in function, 
it may be fastest to finish and test the first button, make copies of it, and then 
make changes in the copies. Things you would usually change would be the name, the 
picture, and perhaps the assigned sound.  This is a real time saver when your 
buttons have multiple actions, and all or most of the actions are the same for each 
button.

Tip 6: If you use the default choice to play a page sound, you can only have one 
sound per page. But both toolbar and page buttons can control sounds with a Play 
Sound action and a highlighted sound in the sounds list. This gives you the power to 
have multiple sounds play on a page.  You could have several buttons with sounds 
for students to click. 
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You also could hide a toolbar full of sound buttons, and have a visible button choose 
one of the hidden buttons to play sounds. A third choice is to hide the sound 
buttons toolbar, and then have a series of page actions that would choose each of 
the sound buttons in the order you desire when the page opens. 

Tip 7: The Select Object... action is very powerful, and yet it is often overlooked. 
You can type in the name of text boxes, page buttons, and graphics that are on the 
current page.  You can even use it for a hidden page button. Selecting a page 
button is just like clicking it. For text boxes and graphics, you would use Select 
Object “Name” followed by an action that affects that object. Here we select a 
text box and read it out. If there were three text boxes, each with a different 
name, you would use three Select Object actions, each followed by Read All.  You 
could also do other things, like select a graphic and move it to a region.

Tip 8: Use finished activities, both ones you have made and others, as templates.  
Customizing or adding onto an activity saves you time. You may need several 
versions of an activity to use with different students. It also is a good way to 
stretch your authoring skills without biting off too much at once.  If you use 
another author’s activity, spend enough time looking behind the scenes to be sure 
you understand how it works.  Then make whatever changes will  fine-tune it for 
your students’ needs.

Tip 9: Use Paint mode to create a floating graphic you can animate from a 
background photo.  The procedure is to go into Paint mode, select and copy the 
rectangular area you need, go immediately back to Design mode, and paste. The 
result is a floating graphic that you can animate. If you need to trim the rectangle 
to the edge of a shape, go to a new blank page while in Paint mode, paste the 
rectangle, and erase around it. Then select and copy again, go to Design mode, and 
paste. 

Tip 10: When objects are stacked on top of one another, you can still easily select 
one for editing by choosing Select Object from the Edit menu, and picking the 
object from the list of object names in the flip out menu beside it. Next choose 
Properties... from the Edit menu to open the Properties window for the selected 
object.

Tip 11: If a graphic will not be clicked by a student, remove it from scans by 
opening Properties and taking off the checkmarks under the Scanning tab. Also 
remove the checkmark from Respond to Mouse Clicks, to prevent a reaction from 
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direct selection. If a student can interact with a graphic, there should be some 
effect or reward; otherwise, set it so it seems to be part of the background.

Tip 12: The timeline really does act like a time machine. If you forgot and made a 
change at, say, 2 sec, then it would not be there at time 0.  Things added at 0 
remain for future points unless you delete them at a later timepoint. In fact, like in 
the real world, things added at any timepoint will  remain at a later new timepoint, 
but will not appear at earlier timepoints.

Tip 13: You can use the Set IntelliMation Time... action as a reset.  If you play an 
animation, it does not automatically jump back to 0 seconds after it plays. A button 
with Play IntelliMation and Page Sound will indeed cause it to go to the 0 point 
and play to the end. But having it jump back when the button is clicked sometimes 
looks silly. If so, add Set IntellMation Time to 0 after Play IntelliMation and 
Page Sound.

Tip 14: Activating the (Wait) option for Play Sound makes certain that the sound 
will play completely before going on to the next action.  This may be exactly what 
you need to have a voice-over complete itself.  It can also make sure a sound 
finishes before going to the next page. If a sound is being cut off by the next 
action, turn on (Wait)!

Tip 15: You can use the Transform Tools within an IntelliMation to create the 
illusion of something moving closer or farther away.  Don’t try to change the size 
yourself at every half second.  Just set the size you want at the beginning, jump to 
the timepoint where you want to end up, and reset the size there. Classroom Suite 
will smoothly change the size in between. This tweening effect is built right in!

Tip 16: You can create animations longer than 5 seconds by clicking the plus 5 
seconds button.  The timeline is as long as you want it to be! You can move back to a 
previous 5 second section by clicking the minus 5 seconds button.

Tip 17: In building a complex animation, plan ahead to delete items you no longer 
need, use the fewest possible points, and do segments in the order that will make 
best use of elements already in place. This will help you do the animation faster, 
and also make it easier to edit if necessary.  If you make a change in the middle of 
a bunch of timepoints, you must make that change in each later timepoint.
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Tip 18: Use Play Range, an advanced IntelliMation option, to play a part of an 
IntelliMation.  By specifying several different ranges in various buttons, you can in 
effect have more than one animation on a single page.

Tip 19: Combining the Choose Random function with a toolbar of buttons that use 
Play Range lets you create cause and effect activities in which the animation 
doesn’t always come out the same.  

Tip 20: You can edit a button partway through an IntelliMation so that it looks 
different and has different actions. By having the action stop where the edited 
button resides in time, you can let students interact within an animation.

Tip 21: You can take a screen shot of the thumbnails in Sort Pages... to make a 
flowchart of a multi-page activity. But for this activity, which all takes place on one 
page, I used pieces of clip art from the activity to show the flow of the actions.
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